
 Chapter 4.

Forms and Browses

Forms and Browses are the heart of data entry.

With Alpha Five, it is easy to create tabbed interfaces that are familiar to Windows users.
Forms organize the input of data. Browses also assist the user in entering and viewing data.
And, best of all, the built-in design aides make everyone look like a pro!
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CHAPTER 4. FORMS AND BROWSES
Overview

Overview

We cover a LOT in this chapter. Since it so lengthy, we’ve broken it down into sections. Here’s a quick review of the
topics and where you’ll find them when you need a refresher for your own application. Exercises are created in “teaching
order,” so look in around for what you need. Full details in the index. New Version 10 features are in green. 

Topic Page

Part 1. The basics of form design

     ‘Understanding form design’: Default & Custom Forms, Menus and Toolbars. 69

     ‘Understanding the Task Panes’: Views, Properties Pane, Toolbox, DragDrop List, Browse Con-
trols, Interactive Window, Testing, Restoring to a prior version.

86

Part 2. Tabbed forms

     ‘Creating a tabbed form’: Form title, Creating and modifying tab panes. 103

Part 3. Embedded browses

     ‘Understanding Browses’: Difference between stand-alone and embedded browses. 111

     ‘Creating an Embedded Browse’: Create and customize embedded browses, Order records (for 
form), Read Only, Sorting, Undo & Redo commands.

111

Part 4. Placing fields and navigating records

     ‘Placing One–to–One fields on the form’: Place and adjust fields, Ungroup, Copy attributes. 122

     ‘Adding a record navigator’: Move tab pane objects, Navigator control. 129

     ‘Placing One-to-Many fields on a form’: How to put them in a form. 131

Part 5. Learning about dynamic objects and form level rules 

     ‘Adding dynamic references’: Dynamic form title and reference fields, read only. 132

     ‘Creating form level field rules’: Differences between rules & properties, form level rules. 136

Part 5. Learning the Expression Builder

     ‘Understanding the Expression Builder’: Tour, Functions, Library, Toolbar, Enter Expressions. 143

     ‘Creating calculated fields’: Character, Alltrim, Numeric, Combine field types, Edit. 153

Part 6. Adding more features

     ‘Refining the form’: Rich Text, Copy / Paste from another form, Tab Order, Title bar name, Smart 
fields, Header & Footer.

159

     ‘Using a Web form on the desktop’: Add existing component to desktop application. 167

Part 7: Stand-alone Browses

     ‘Understanding Stand-Alone Browses’: Design elements, Conditional color, Vertical slider. 168

     ‘Putting a button, a smart field and an ellipsis in a browse’ 173

     ‘Using the Ad Hoc browse’ 176
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Preparation for the Lesson.
Open Alpha Five and navigate to the following file:

•c:\A5_Ver10Book\ABC_V10_Lessons\ABC Seminars.adb*

•  Click on the Control Panel tab in the Window Bar at the bot-
tom of the screen to bring the Control Panel to the front.

SPECIAL NOTES As fields are added to the form, the Summary Genie may pop-up. Accept the default
settings and click Finish. The genie may be deactivated by clicking the “magic lamp” in
the upper right corner of the toolbox.

Because this is a long chapter, it has been broken into a series of exercises. The quill
and inkwell marks the beginning and end of each segment.

Understanding form design

Forms are used for entering, changing and viewing data.
Objects are placed on forms. Much the same as a remote control, magazine and lamp

are objects placed on a table, fields, labels and buttons are objects that are placed on a
form.

Forms may also be printed, but usually you will want to create a separate form or
report that is formatted specifically for printing. Forms can be imported from the Report
Editor. (See “Importing a layout” on page 239.)

There are three types of forms, two of which, Default and Custom are created by the
Genie. The third, Blank Form, is ready for your personal design. All forms can be mod-
ified to suit your needs.

•Blank Forms begin as a blank sheet of electronic paper.

•Default Forms contain every field in the table or set. These are the quickest 
to make, but often contain more fields than are useful for data entry. 

•Custom Forms are also easy and quick to make. This style is more useful 
because it can be limited to specific fields.

In this exercise, we will briefly demonstrate the process for creating a Default Form
and using Stylesheets. We will then create a simple, basic Custom Form. At that time
we will illustrate how fields are placed on the form and will examine the components of
Form Design.

Finally, we will create a new form from scratch so we can give the user all the Win-
dows bells and whistles, including tabbed interfaces and embedded browses. 

Creating a default form
The default form contains all the fields in the table or set. This is the most basic type

of form and is designed completely by the genie, making it very simple to create. We
will also look at the Alpha Five Stylesheets feature.

1. At the Alpha Five Control Panel Tab, click the Forms tab.

*. Depending on how Alpha Five is opened, the file extension .adb may not appear. (For instructions on opening an existing database, 
see “Opening an existing database” on page 14.)
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2. Click New button.

3. Data Source: Choose Clients_form (Set). (Click Next)

•Sets are identified by a three-box graphic at the left of the listing.

•A single box means it is a table.

4. Choose Default Form (contains all of the fields in the Table/Set.)
(Click Next)

5. Stylesheet: Choose Subtle Glass.

•Stylesheets will help your designs maintain a consistent appearance. There 
are several pre-designed stylesheets. Custom stylesheets can also be created.

•Stylesheets are discussed at length page 511 in the Bonus Pages.

6. Click Next and then Finish.

•The Form Editor opens to a three page tabbed interface. The first 
page contains all of the fields in the one-to-one links in the set.

•The second and third pages contain the one-to-many links in the set. 

These appear as Embedded Browses (red box below).*

7. Click the Page 2 tab to access the page.

 Previous to Version 9, you had to press the tab twice in Design Mode. Tabbed
forms created in earlier versions may still require the tab to be clicked twice.

The Default Form may be edited. The positions of the fields can be changed and
fields can be removed. 

STYLESHEET GALLERY 8.  Click the button at the left of the top row of buttons (Form view)
to see the results of the stylesheet selection.

•It takes you from Design Mode to Form View.

9. Examine the background and font colors of the form.

10.  Click the top left again. (This time the bubble help says Design
Mode.)

*. Embedded browses will be discussed in this chapter. (See “Creating an Embedded Browse” on page 111.)



ALPHA FIVE MADE EASY
The Basics and More for Version 10

71

11. Choose Stylesheets > Apply or Create a Stylesheet from the top
menu.

•The Style Sheet Gallery 
appears.

12. Click on Green.

•The checkbox at the bottom 
will reveal “Legacy 
Stylesheets.” These were cre-
ated in earlier versions of Alpha 
Five. Feel free to choose one of 
these if it appeals to you. 

13. Click Apply.

14. Click Entire Form.

15. Click Close.

16. Click the tabs to see the
color changes.

17.  Click Form View.

•This view shows the new appearance with data.

18. Repeat above to experiment with some other styles, if you like.

MORE ABOUT STYLESHEETS Look in the Bonus Pages! “Understanding Styles and Stylesheets” on
page 511 gives instructions on creating custom stylesheets, as well as updating and

managing them.*

19. Click X in the upper right corner at either Form View or Design Mode.
Close the form without saving as follows: 

•Form view: Click Cancel at the “Save Form As” dialog box.

•Design Mode: Click No at the “Save changes to current form” dialog.

Creating a Custom Form
Next, we will create a form that contains specific fields. We will also examine the

form design tools.

20. At the Alpha Five Control Panel Tab, click the Forms tab.

21. Click New button.

22. Data Source: Choose Clients_form (Set). (Click Next)

23. Choose Custom Form (contains fields that you select). (Click Next)

24. Select the following fields.

HINT! For this type of field selection dialog, highlight your first choice and then click the
RIGHT ARROW button repeatedly to enter your choices into the Fields on Form win-
dow. (In this case, click the button 6 times.)

*. See “Remember the Bonus Pages!” on page xiii.
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•Client ID

•Enter Date

•First Name

•Middle Initial

•Last Name

•Company

25. Click Next.

26. Stylesheet: Alpha Five Default (or any other
you choose). (Click Next.)

VIEW XBASIC CODE Now we will check out another very useful Alpha Five feature. Throughout the pro-
gram are opportunities for you to view the Xbasic code that is created by the Genie. As
you advance in learning the program, you can take advantage of this by cutting and past-
ing the code to your own scripts.

At this time, we will only look at the code. You will learn
more about Xbasic in a later chapter.

27. Click Show Xbasic.

•The Xbasic Form Genie window appears.

 NOTE

No doubt, some of you are licking your chops, anxious to
get your teeth into writing code. Others have faces that
pale at the mention of it. To the first, I say “Be Patient,”
and to the second “Don’t panic!” Alpha Five has been
designed with both of you in mind. It can be used with or
without the more advanced development vehicles.

28. Close the Genie by clicking the X in the upper
right corner.

29. Click Finish.

•The form opens with only the 
fields that we indicated.

THE DESIGN TOOLS
In the illustration at left, Bubble
Help appears below the Toolbox
button (red box) because the cur-
sor is placed on the button. The
following may also be seen in the
screen shot.

•The Top Menu is the row of text 
options at the top of the window. 
See “Understanding the Top 
Menu” on page 73.



ALPHA FIVE MADE EASY
The Basics and More for Version 10

73

•The Forms Toolbar is the row of buttons below the Top Menu. 
See “Understanding the forms toolbar” on page 77.

• The Toolbox and DragDrop List are at the right. If you do not see them on 
your screen, click their buttons on the Forms Toolbar. The buttons turn 
orange when they are pressed. See “Using the Toolbox” on page 89 and 
“Using the DragDrop List” on page 93.

•The Properties Dock Panel is at the left of the screen. If you do not see it, choose 
Top Menu > Task List > Properties. see “Using the Properties Pane” on page 100.
We will also use:

•The Right Click Menu.

30. Hover your cursor over the Company field.

•Bubble help gives you information on the field.

31. Click the Company field to give it focus - black boxes surround the
field.

•The Properties Dock Panel (aka Properties Pane) changes to show the avail-
able selections for the field.

32. Right click on the field to see the Right Click Menu.*

• Next, we will examine all the design tools in detail.

Understanding the Top Menu

PLEASE TAKE A MOMENT TO 
READ THIS

As in most Windows programs, many of the sub-menu items are duplicated else-
where; we will define only those that are unique. Open the menus as you read along to
become familiar with the extensive features.

• File and Edit menus contain typical Windows items and their Keyboard Shortcuts.

• View

•Trace Window. Alpha Five reports errors here. (See “Understanding the 
Trace Window” on page 476.)

•Script Recorder Window. Scripts are custom actions that you can create for 
your application. This handy tool will allow you to create scripts by record-
ing your selections. 

•Code Editor. Allows you to create and edit scripts.

•OLE Automation Browser: Allows you to investigate the properties, meth-
ods, events and constants of ActiveX controls on your computer. 
(Advanced)

•HTML Editor. Allows you to create web pages.

•Debugger. A tool for proofing scripts. Totally revamped for Version 10. 

*. (See also “Using the Right Click Menu” on page 84.)
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VIDEO HELP* Go to Top Menu > Help > What’s New in Version 10 > Desktop Applications >
Debugger.

•Status Bar. Information bar at the bottom of the screen. Toggles Show / No 
Show.

•Window Bar. Buttons at the bottom of the screen that access the Control 
Panel and other open windows. Toggles Show / No Show.

•Settings. Global preferences for the database.

•The next seven items are duplicated by buttons. See “Understanding the 
forms toolbar” on page 77.

•Object bubble help can be turned on or off. It appears when you hover the 
cursor over an object (field, label, etc.) on the form or the DragDrop List. 

VERY USEFUL IN FORM AND 
REPORT DESIGN

•Structure Information shows the tables in the set and their relationship.The 
double bar arrow indicates one-to-many. The single bar arrow means the 
relationship is one-to-one.

a. Click on Structure Information, then click on a Table.

b. Click on the Fields tab.

•The fields in the table are listed with their type and size.

c. Click the A-Z button at the lower left. The fields are shown in alpha-
betical order, helpful for a large table.

d. Click on the Indexes tab to see those created for each table. (See 
“Understanding Indexes” on page 317.)

e. Click on the Statistics tab to see how many records exist and other 
information about the Table.

*. There are several videos in Top Menu > Help > What’s New in Version 10. Look for the camera icon.
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f. Click CLOSE.

g. Click VIEW on the Top Menu to reopen the list.

•Object Explorer shows all properties of all 

objects on the form. *

ADVANCED

If you are new to form design, you may skip
ahead to “Task List” on page 75. Come back
here after you finish this chapter. It will have
more meaning at that time.

a. Choose Object Explorer.

b. Click on first_name_lbl (label).

c. Drill down† a couple of categories to see the 
Properties that can be changed in both Design 
and Form Views. 

d. Changes are made by choosing from the lower 
window and clicking Set.

NOTE

While useful in Form View for quickly modify-
ing an object without returning to Design Mode,
there are easier ways to set these properties
while designing.

e. Go to Form view.

f. Move the Object Explorer window if neces-
sary. It will close automatically.

g. Click on an object to activate it.

h. Re-open the Object Explorer.

i. Click Current Object to quickly go to the object you want to modify.

j. Experiment with options to change font, color, etc.

ROLL- UPS Certain windows can be rolled up so they can remain handy, yet are out of the way.

k. Click Roll-Up.

l. Click Expand Object Explorer.

m. Click CLOSE

n. Return to Design Mode and then reopen the View list to continue.

•Code Explorer lists the Events (see below) that have been designed for the 
form. Modified for Version 10 to allow code to be edited.

• Task List

*. Xbasic scripts: A primary use for the Object Explorer is to quickly find the name of the object in a form with many fields. This can 
be useful in Xbasic scripts. For more information, go to A5 Help > User Guide > Form Design > Object Properties > Object 
Explorer. This entry also contains an interesting discussion on the names of objects. The name of the object may also be found by 
right clicking on the field in Design Mode and choosing Properties.

†. Drill down means to click on the + sign next to the menu item to open the next set of selections.
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•Toolbox and DragDrop List are duplicated on the Forms Toolbar (see 
“Using the views” on page 87 and “Using the DragDrop List” on page 93.).

•Interactive opens a window at the lower right where a line of code may be 
tested.

•Browse Controls: Allow you to insert buttons and images in both Embedded 
and Stand Alone Browses. (See “Using Browse Controls” on page 96.)

•Properties: Opens the Properties Pane aka Properties Dock Panel.

•Restore Default Layout opens the DragDrop List and Toolbox at the right 
side of the screen, one above the other.

• Form

•Form View is the same as the left button on the Toolbar.

•Form Properties contains settings for the form.

•Events are actions that can be set for the form using Action Scripting or Xba-
sic.

•The Grid is on the background of the form in Design 
Mode. 

a. Click Grid to open.

b. Grid Spacing: The default is 10 dot markers per 
inch.

•Grid Spacing affects the distance between fields as 
they are dragged onto the form. To have the fields 
touching, accept the default of 10. To space them 

apart, try a larger grid.*

c. Snap to Grid means that objects move to the grid 
when they are near it. This helps align items. Snap 

may be turned off. 

d. Show Grid: You may elect to show or not show the grid.

e. Change the Grid Spacing to 15.

f. Click OK to see the change in the grid, then reopen the Form menu.

g. Reset the spacing so that objects are touching (10 dot markers per 
inch) because we will use that setting for our exercises. (Click OK)

•Dynamic Guidelines: Aids for lining up objects on the form. Toggles on/off. 
We recommend you keep them on. (See “Using Dynamic Guidelines” on 
page 84.)

•Calculated fields and Variables†. (See Toolbar below)

• Object

•New covers the same tasks as the Toolbox.

•Properties: (see Toolbar, Right Click Menu and Hot Keys below.)

•Events (see Toolbar, Right Click Menu and Hot Keys below.)

•Pop-up Event Editor (see Toolbar below).

*. See step 3 on page 123.

†. See “Introducing Variables” on page 425.
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•Size-to-Fit (see Right Click Menu below and Arrange Toolbar.)

• Arrange

•Most of these items are on the Arrange Toolbar.

•Set Tab Order sets the order of movement from field to field by the TAB 
key. 

By Example (see Toolbar below)

By Table: Fields are listed and may be moved up or down.

• Stylesheets

•Consistent colors and fonts make an application more pleasing to the end 
user. 

•See “Stylesheet Gallery” on page 70, and Bonus Pages: “Understanding 
Styles and Stylesheets” on page 511. 

•See also“Using the Right Click Menu” on page 84 for additional Stylesheet 
aids.

• Window:

•Cascade, Tile Horizontally, Tile Vertically, Arrange Icons are typical Win-
dows choices.

•Open Windows: Items after the thin gray line are open Alpha Five windows. 
This is a handy method for moving back and forth between open windows, 
especially if you like to work with the View > Window Bar closed to allow 

for larger work space. The form with focus* (ClientInfo in example at left) 
is bolded.

Understanding the forms toolbar
In addition to some common Windows buttons, the Toolbar contains very useful

form design buttons.

33. With your mouse, hover the cursor over the top row of buttons to
become familiar with their descriptions and short cut keys.

•Reading left to right, the first set of buttons activate:

a. Button 1: Form View. 

HINT! You can switch back and forth between Design and Form Views while testing the
design. While you are not required to save design edits when testing in Form Mode, it is
recommended that you become a Frequent Saver.

b. Buttons 2, 3, 4: New Layout, Open layout, Save Layout.

c. Buttons 5, 6, 7: Print, Print Preview, Print Setup.

d. Buttons 8, 9, 10, 11: Cut, Copy, Paste, Delete.

*. The active window is said to have “focus.”
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e. Button 12: Undo. Keyboard shortcut is ALT + BACKSPACE.* 

f.  Button 13: Redo. 
Several layers of Undo and Redo are available. As in other Windows applications,

once the record is saved, previous Undo’s and Redo’s are lost. (The button will be
greyed out when the option is not available.)

g. Button 14: Properties. All objects have properties that can be viewed 
and adjusted here. (Also has Right Click Menu and Hot Key options 
(F12) that we find more useful.) 

h. Button 15: Events that have been designed for the form or object can 
be viewed here. Window launches the Script Editor. (Also has Right 
Click Menu and Hot Key options (F11) that we find more useful.) 

IMPORTANT NOTE These menu options are Context Sensitive. When the Form has focus, Form Proper-
ties are displayed. When a different object has focus, its properties come up. The same
is true for Events.

• The following buttons toggle between Show and No Show. (Orange color means 
they are showing.)

i. Button 16: Rulers.

j. Button 17: Toolbox. Contains form design tools.

k. Button 18: DragDrop List. Contains available fields for easy place-
ment on form.

We recommend working with Rulers, Toolbox and DragDrop List in the Show posi-
tion. They may be toggled off when they are in the way. 

The following can be turned on and off depending on the task at hand. 

l. Button 19: Text Toolbar.

m. Button 20: Border Toolbar.

n. Button 21: Arrange Toolbar.

o. Button 22: Copy Format Toolbar.

p.  Button 23: Anchor Toolbar† 

q. Buttons 24, 25: Group and Ungroup. Also available on the Arrange 
Toolbar.

• These buttons open lists for editing purposes.

r. Buttons 26, 27: Display the Calculated Fields and Variables that 
have been designed for this form.

•Note these buttons only work when Calculated Fields and/or Variables have 
been designed for the form.

s. Button 28: Alpha Five Control Panel: This button functions the 
same as the Control Panel tab at the bottom left of the 
screen. It is always placed at the far right side of the cur-
rent toolbar for easy access. It quickly brings the Alpha 
Five Control Panel to the front position. 

*. Windows Undo keyboard shortcut, CTRL + Z is not enabled.

†. Also called Stretch Toolbar.


